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System Overview  
 

Contract Management Tracking Software offers contract managers, administrators, and professionals the ability 

to easily track, renew, cancel or report on their contracts. Oftentimes, organizations have to engage in many 

contracts, such as, elevator maintenance, software license, telephone service, or sub-contractor contracts. 

Overtime it may be difficult to keep track of the renewal, review, or cancellation dates that make up the 

individual contracts. Moreover, a loss of productivity and increase expenses may arise from an inefficient 

contract administration process. Contract administrators may find that they are overwhelmed with the number 

of contracts they must track, report on, renew and cancel. They may find that it is inefficient to use a standard 

filing system via filing cabinets. Contract Management Tracking Software provides a simple solution to solve 

these problems. 

 

CobbleStone Systems Contract Management Tracking Software provides a client-server and Windows-based 

contract management software solutions. For a web-based, enterprise contract management solution, please visit 

our website at http://www.CobbleStoneSytems.com and select ‘Enterprise Edition’.  

 

Contract Management Tracking Software can run on a single desktop, laptop computer or be used on a Local 

Area Network (LAN) in a multi-user environment. It can track important information pertaining to contracts 

such as: dates, notes, titles, employees, income, expenses, vendors, digital image of the actual contract (scanner 

not included), voice message, auto dial, early notification of expiring contract, and offers an automatic renewal 

feature.  

 

In the sections to follow you will find the System Requirements, Installation Procedures, as well as the User 

Guide. 

 

http://www.cobblestonesytems.com/
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Contract Insight System Requirements 
 

 

 

Typical Installation Operating System Requirements 

 Microsoft Windows® 98  

 Microsoft Windows NT® 4.0 (SP 6a required)  

 Microsoft Windows Millennium Edition (Windows Me)  

 Microsoft Windows 2000 (SP2 Recommended)  

 Microsoft Windows XP Professional  

 Microsoft Windows XP Home Edition  

 

PC Hardware System Requirements  

 Microsoft Windows 98/2000/XP (or better) operating system.  

 A personal computer with a 486DX 66 megahertz (MHz) or faster processor (Pentium central processing 

unit recommended).  

 64 megabytes (MB) of memory (128 MB recommended).  

 hard disk space requires 500 MB of free hard disk space (at least 200 MB of free disk space)  

 VGA or higher resolution (16-bit or 24-bit color SVGA recommended). 

 Mouse or compatible pointing device.  

 Computer capable of supporting the Microsoft .NET Framework 1.0 and 2.0 

 

Optional  

 Scanner with Scanner Software  

 Soundcard with audio recording and playback device  

http://www.microsoft.com/ntserver/nts/downloads/recommended/SP6/allSP6.asp
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Installation Procedures  
Installing Contract Management Software from the Internet at http://www.cobblestonesystems.com  

1. Create a temporary Folder on your hard drive.  

2. Download installation file to a temporary location on your hard drive or select ‘Run’ to start the 

installation.  

 
3. Select ‘Next,  

../../../../Local%20Settings/Temp/Rar$DI01.766/contract_management_software_desktop_download.htm
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4. Modify the installation path if needed and select ‘Next’, 

 
5. Select ‘Next’ to confirm the installation, 
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6. Select ‘Close’ to complete the installation or follow the Installation Wizard to complete the 

installation process.  

 

 

Uninstalling (Removing) Contract Management Software 

Prior to un-installing or upgrading ContractInsight, be sure to backup the Contract.mdb file in the 

“C:\Program Files\CobbleStone\ContractInsight\” file directory (or the selected installation 

directory when installed). This will ensure that you do not lose any data entered into the system 

prior to an update.  

To uninstall, be sure to backup as per the instructions above. Next, select "Add/Remove 

Programs" in the Windows Control Panel. Select "Contract Management Software" from the list 

and select "Add/Remove". Follow the uninstall wizard. 

Note: All data will be removed upon uninstalling Contract Management Software. 
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Multi-User Environment 

 

Working in a Multi-User Environment 

To use Contract Management Tracking System in a multi-user environment there are several 

configuration steps.  

1. Purchase and install the system on each computer (select the default options upon installation). Do 

not add any data until the configuration is complete. 

2. Next, select a shared network folder or directory and a copy and paste the "Contract.mdb" file in the 

shared folder (not the full path to this directory). The Contract.mdb file can be found among the 

installations files (typically in the C:\Program Files\CobbleStone Systems\ folder – path may vary).  

3. Locate and edit the application configuration file [ ] (using Notepad) 

found in the installation path of each PC that the system in installed on. Modify the “Data Source” 

string as follows: 

Replace the |DataDirectory| text seen below with the full network path to the Contract.MDB file that 

was moved in Step 2 above. 

 

In the example below we moved the Contract.mdb file to a network path of 

w:\Data\SharedFiles\Contract.mdb (your path will vary depending on the network path your network 

administrator set up).  

 

Be sure to modify the Data Source network path (above) from  

“|DataDirectory|\Contract.mdb” (or “contract.mdb”) 

to 

“\\ServerNameOrDriveLetter\path\contract.mdb” (without the quotes). 

4. Next, locate the DBPath setting in the  configuration file and enter 

the correct network path to the Contract.mdb file (this will be the path ONLY and will NOT 

include the Contract.mdb file as part of the path) 
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5. Next, locate the FilePath setting (seen above). Enter the full network path here as well. This will 

tell the system where to move attached files when they are attached.  

 

To use a network version of the system, you must alter the “Data Source” string.  

For example, if you have a network shared drive entitled "N" for N drive and the "Contract.mdb" file is 

on the following path "N:\contracts \contract.mdb".  

NOTE: You can also use the UNC. For example, "\\servername\path\contract.mdb". Also, be careful and 

make sure all of the string is type properly.  The application configuration file should be modified on all 

user’s computers that need to share the database.  

Location of Scanned Files and Tracked Documents: 

Configuring the location of scanned documents and files.  

To change the configuration of where documents and files are stored, located the Config file in the 

systems installation directory (noted in the installation section of this manual).  Open the .config file 

with notepad.  Locate the FilePath key value (seen below). To modify the location of where scanned 

files and documents are stored, enter the path (or network path) to the location.  NOTE: It is not 

recommended to change this location after the first documented is scanned or file is attached. 
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Starting the Program 

 

Starting Contract Management Software (After the Installation is Complete) 

Select "Start" on your Windows Desktop, select "Programs", "Contract Insight", "Contract 

Insight". This is the preferred method of starting Contract Management Software. 

 

Navigating through the Interface 

The Main File Menu is the best way to navigate through Contract Management. It features buttons that 

correspond to each topic of Contract Management. For example, the Employee button will allow the 

user to view the Employee information, such as, entering a new employee or finding/editing an existing 

employee. A screen shot of the main file menu is below: 

 

Main Menu Options 
 

1. The Contracts, Vendors, Employees, Setup, Actions, Help, and Exit menu options will display 

their respective sub menus.  

2. Selecting the Contracts menu item, and next selecting the Add New item will bring the user to 

the Contract Input Form (see Contract Input Form).  

 
3. The Find menu item will bring the user to the Find a Contract Form (See Find a Contract Form).  

4. The Contract Expiring tabs (seen above) will show the user all the Contracts that are currently 

expiring based on the tab selected.  

5. The Setup menu will bring the user to the various setup files such as Departments, Contract 

Types, Locations, Categories and more. This will be discussed about in greater detail later (seen 

below).  
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Contract Warning System: 

Every time the system is opened the contract management system will scan all expiring contracts based 

on the "End Date" and the "Notify Days" that was entered into your contract records. To open the 

contract, just double-click the line item with your mouse.  

 

 

Alerts will be displayed on the calendar based on the contact or task end date; and based on the notify days 

prior to the contract and task end date (seen below). To view a contract that is displayed on the calendar, 

double click on the Contract Title (seen below)—this will open the contract detail screen.  

 

To refresh the calendar view, select the refresh icon (on the calendar page tool menu).  
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Vendors and Customers (Companies) Management and Setup 
 

 
1. The Manage Vendors and Customers (Companies) menu item will bring the user to the 

Vendor/Customer Input Form (see Vendor Input Form for more details).  

2. To find or view an existing vendor or customer, select ‘Manage Vendors’ then click the vendor in the 

vendor list (seen below). This will allow the user to find a previously entered Vendor.  

 

 

3. to Add an new vendor or customer select the add button  
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Employees Management and Setup 
 

 
 

1. The Manage Employees option will allow the user to view or add Employees (see Employee Input 

Form). This is used to enter a new Employee into the database. Start off by entering all Employees first.  

2. The find or view Employees, select the Manage Employee option, click on the Employee list seen 

below. This will permit the user to view and edit previously entered Employees.  

 
3. to add a new employee, select the add button . 

4. to save changes, select the save button . 

5. to delete an employee, select the delete button . 
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Setting Up Departments, Locations, Contract Status, Categories, and 
Contract Types 
 

It is recommended to add as many Department, Locations, Status, Categories, and Contract Types prior 

to entering your first contract record. 

 

 

 
 

To set up Departments, select the Departments sub menu displayed above. 

 

The Departments Management form will appear.  

 
1. To add a Department, select the Add button , enter the Department name, and be sure to 

select the Save button.  

2. To edit or view a Department, click on the Department in the grid (seen above). Modify the 

Department name if needed, and select Save . 

3. To delete a Department (not recommended if there are contracts assigned to a Department), 

select Delete . 

 

To manage Departments, Locations, Status, Categories, and Contract Types follow the same 

instructions as above except select the appropriate menu item for Locations, Status, Categories, or 

Contract Types. Be sure to set these items (lists) up prior to entering in Contracts.  
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Contract Expiring Message and Notifications 
 

If there are Contracts expiring alerts or Task expiring alerts, you will be notified when you start the 

program. At this point you may choose either to view the contracts or not.  You can view the contract by 

double clicking the row of any contract item showing in the expiring grid (seen below).  You can select 

from the various tabs (seen below) to view contracts expiring by a Calendar (Month) View, Day View, 

or various list views. 

 

 
 

Calendar View: ContractInsight includes several views for displaying Contract and Task alerts. The 

Calendar View is the default view and will display alerts based on the month selected in the Calendar 

View tab. To move and view another month, select the calendar box and navigate to the month, day, and 

year desired.  To open or view an expiring contract or task, double click on the Contract or Task title 

displayed on the calendar.  
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Employee Input Form and Employee Management 

To navigate to the employee input and management form, select the Employee menu item, next select 

the Manage Employees sub-menu item (seen below). 

 
The Employee input and management form will appear in a separate window.  

 

The Employee Input Form allows the user to enter (add) or edit information pertaining to employees. (It 

is recommended that the user enter all Employee and Vendor information before entering contract 

information) 

 To add a new employee, select the Add button . Next, enter in the information about the 

Employee. Next, select the Save button. 

 To edit an employee, select the employee from the Employee List grid (seen above) by double 

clicking on the employee row. Next, modify the data in the fields provided. Next, select the Save 

button. 

 To delete an existing employee (although not recommended unless it was entered by mistake), 

select the employee from the Employee List grid (seen above) by clicking on the employee row. 

Next, select the Delete button . You will be prompted to confirm or cancel the deletion.  
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Find, View, and Edit Employees 

 

1. To edit or view and employee, navigate to the employee input and management form, select the 

Employee menu item, next select the Manage Employees sub-menu item (seen below). 

 
2. The Employee input and management form will appear in a separate window.  

 
3. To find, view, or edit an employee, select the employee from the Employee List grid (seen above) by 

double clicking on the employee row.  

4. Next, modify the data in the fields provided. Next, select the Save button. 
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Vendor and Customer Management  

 

To enter, add, and manage Companies , select the Manage Vendors submenu from the Vendor main 

menu bar (seen below). 

 
The Vendor Management form will appear (seen below).  

 
 

1. The Vendor Input Forms allows the user to enter or edit Companies information.  

2. To add a new Vendor or Customer select the Add button (see above).  

1. next enter in the company information in the fields provided and select Save. 

3. To view or edit an existing Company, double click the Company in the grid seen above. Their data 

will fill in the form.  You may modify the data and select Save to save the changes.  

4. To delete a Company, select the Delete button.  

5. To close the Vendor screen, select the Close button. 

Find Vendor Form 

To find and mange Vendors or Customers, select the Manage Vendors submenu from the Vendor main 

menu bar (seen below). 
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The Vendor Management form will appear (seen below).  

 

 
6. To view or edit an existing Company, double click the Company in the grid seen above. Their data 

will fill in the form.  You may modify the data and select Save to save the changes.  

7. To delete a Company, select the Delete button.  

8. To close the Vendor screen, select the Close button. 
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Contract Entry & Edit Form 
To enter in (add) a new contract record, select the Contracts menu item, then select the Add New 

submenu item. 

 
The Contract record entry will appear. 

 

Next the Contract Input form will display.  Enter the Contract Title, select a Vendor (if a vendor is not in 

the list, close the screen and add a new vendor (see Vendor Management for more info), enter the 

Contract Start Date, enter the Contract End Date, enter the Notify Days (the system will notify you via 

the list box on the main system page based on the number of days entered before the Contract End 

Date), enter a description and additional information. 

 

 
1. The user can enter the following information: The Contract Title, Vendor (select from list), The 

Product, The Contract Start and End Date (Year 2000 Compliant), Employee Contact (select 

from list) and Signed By information.   

2. The Type list box can be used to track various types of agreements, such as: leases, licenses, 

maintenance, health care agreement, filings, and other committals.   

3. The Contract Code can be used to track Contracts by specific codes. You may also print 

Contracts by Code.  
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4. The Confidential, Term, Terminal, Warranty, Payments, and General tabs enable users to track 

large amounts of text about the contract.  

5. The Notify Days field informs the database of when to notify you when the contract is expiring.  

6. The Financials Tab will show the Income/Expense Tracking screen to enable your users to track 

financial transactions.  

1. You may enter Deposit and Withdraw information in the Income/Expense Tracking 

Screens. Contract Balance is automatically calculated.  

7. The Tasks/Alerts tab enables users to add and track multiple tasks and assign the tasks to other 

employees.   

8. The File/Documents tab allows the user to add or view the files, documents, and scanned images 

of a Contract.  

9. Action buttons: the Save button will save your entry, the Close button will cancel the entry or 

changes and close the entry screen, and the Delete button will permanently delete the contract 

record.  
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Contract Task Alerts and Task Management 
 

The Tasks/Alerts tab enables users to add and track multiple tasks and assign the tasks to other employees.   

 
Note: before entering tasks into a contract, be sure to select the ‘Save Data’ button on the contract entry 

screen. 

1. To add a new task for a contract, select the Tasks/Alerts tab on an existing contract record. 

2. Next, select the ‘Add Task’ button on the Task menu control.  

3. Next, enter in the Task Name, select an Employee, enter in the task start date and task end date, 

enter in the notify days, enter in notes if needed, and be sure to select the ‘Add task’ button (seen 

above). 

4. The new tasks we be displayed in the grid (seen above). 

5. To view an existing Task, select the task in the grid (seen above) and click the row.  

6. The Task edit screen will appear (seen below). Edit the values and select ‘Save task’ to save your 

changes. Select the ‘Delete task’ button to delete the task.  
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Contract Notes 
 

The Notes tab enables users to add and track multiple notes per contract record.   

 
Note: before entering Notes into a contract, be sure to select the ‘Save Data’ button on the contract entry 

screen. 

 

1. To add a new note for a contract, select the Notes tab on an existing contract record. 

2. Next, select the ‘Add note’ button on the Notes tab menu control.  

3. Next, enter in the Notes text and enter in the date, enter in notes if needed, and be sure to select 

the Add note button (seen above). 
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4. The new notes we be displayed in the grid (seen above). 

To view an existing note, select the Notes tab and select a Note item in the grid (seen above).  

The Note edit screen will appear (seen above). Edit the values and select ‘Save note’ to save your changes. 

Select the ‘Delete note’ button to delete the selected note. 
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Find Contract Form 
 
 

 
To begin the process of finding or locating an existing contract record, select the Contracts menu, next 

select the Find submenu item. The Find Contract screen will appear.  

 
To find a Contract by Vendor, select a Vendor from the Search By list, enter a value in the entry box 

(seen above), and click the corresponding Search button. Repeat this process for search by other search 

criteria. The contract search results will appear in the grid (seen above). To view a contract record, 

double click on the row in the grid and the Contract Add/Edit screen will appear.  

Examples: 

 To find a Contract by Employee, select an Employee from the list and click the corresponding 

button.  

 To find a Contract by Product, select a Product from the list and click the corresponding button.  
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Scanned Image, Scanning Documents, Attaching Files 
 

The Files/Documents (images) tab allows the user to enter files and other objects such as Scanned 

Images, Voice Messages, Word Documents, spreadsheets, PDF files, multi-page TIF files, or any other 

supported Object File.  

 
Note: before entering files/documents into a contract, be sure to select the ‘Save Data’ button on the 

contract entry screen. 

 

 

To insert a scanned file do the following: 

1. First scan the image of a Contract using your scanner and scanner software (scanner not included 

with they system). Save the scanned contract (or document) to a file location with a name you 

are familiar with (apostrophes in the file name are not supported). Note: it is recommended to 

scan images and document to the multi-page tiff (TIF) format. Please refer to you scanner 

documentation to convert scanned documents to multi-page tif format or contact CobbleStone 

support. 

2. From the Images/Files tab (located on the Contract screen) select Add new File button, next, the 

file dialog box will appear (seen above).  Next, navigate to the folder location of the scanned file 

(or other file), select the file, select Open.  The file will be added to the contract record.  The files 

will be displayed in the data grid (seen above). Note: additional software or hardware may be 

required.  

3. To view or open a file, select a file in the data grid, next double click on the row selected.  The 

software will open the document.  

4. To delete a file, select the file (in the data grid row), next select the Delete File button and 

confirm the delete (this cannot be undone).  
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To add a saved file (such as MS Word, Excel, Emails, or PDF files), follow the same steps.  

 

Configuring the location of scanned documents and files.  

To change the configuration of where documents and files are stored, located the Config file in the 

systems installation directory (noted in the installation section of this manual).  Open the .config file 

with notepad.  Locate the FilePath key value (seen below). To modify the location of where scanned 

files and documents are stored, enter the path (or network path) to the location.  NOTE: It is not 

recommended to change this location after the first documented is scanned or file is attached. 
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Enter/Edit Income and Expense Transactions 
 

 
Note: before entering tasks into a contract, be sure to select the ‘Save Data’ button on the contract entry 

screen. 

 

From the contract add or edit screen, select the Financials tab (seen above) to enter or edit financial 

tracking information for a particular contract.  This enables a user to track Income, Expense or Hourly 

Tracking for a particular Contract go to the Contract you would like to edit or add transactions to and 

select the Financials tab. The form above will appear. Enter each line item in the entry boxes seen 

above. Be sure to select the ‘Add” button seen above. The totals will appear at the bottom. Note: This 

can be found at the top of the Contract Form.  
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Reports and Reporting 
 

s 

1. To run or view a standard reports, select a report from the Report menu. 

2. Next, select corresponding report submenu and report name (seen above). Note: A default printer must 

be specified before viewing reports from the Printer settings in the user’s Windows Control Panel..  

3. The Report Page allows the user to view the selected report, print the report by selecting the printer icon, 

and find specified text by selecting the binoculars icon. (seen below)  

4. There are a number of standard reports included in the System.  To create a custom report, please refer 

to Creating a Custom Report in this manual. 

s 
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Contract Insight Report Builder 

Customized Reports with Report Builder 
Contract Insight comes with a full Report Writer tool entitled Contract Insight Report Builder. Report Builder is a very 
powerful end-user reporting tool and some reporting experience will be helpful. Knowledge of MS Access Reporting or 
Crystal Reports will be helpful, as to the concepts of Report Builder are very similar. This document will not cover all 
features of the Report Builder, however, a good summary is provided below.  
Upon launching Report Builder from the Reports menu, the report designer page will be load and pre-set with the 
Contract Data source.  

 
With its various tools and features the Contract Insight Report Builder offers great flexibility in constructing report 
projects.  
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Report Designer Section: 

 

The report design surface is made up of the following base components: 
1. PageHeader section--This section can be used to print column headers, page numbers, page titles, or any 

information that needs to be printed once at the top of each page. Bound controls in the PageHeader or 

PageFooter are not supported.  The data in such controls may not be in synch with the data displayed in other 

sections on the page.  

2. Detail section--This section is the body of the report that prints once for each record in the data source.  

3. DataSource icon--This control can be used to connect the report's data source settings to an existing data source  

4. PageFooter section--This section can be used to print page totals, page numbers or any other information that 

needs to be printed once at the bottom of each page.  

5. Designer/Script/Preview tabs--The Designer and Script tabs can be clicked to toggle between design and script 

views, while the Preview tab allows for a fully functional design-time preview of how a report will look and 

behave at run time.   

The designer tabs located at the bottom of the Report Builder design surface allow you to quickly access various aspects of 
Report Builder. The Report Builder designer is equipped with three tabs, the Designer tab, the Script tab, and the Preview 
tab.  

 Designer Tab: By default, when you create or open a Report when the designer tab is selected. While in this tab of 
the Report Builder, you can perform all design-time and run-time functions associated with your report, such as 
creating a layout, binding to data sources, creating event-handling methods, and more.  
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 Script Tab: By selecting the Script tab, you open the script editor, which gives you the ability to easily and quickly 
add scripting to your report. The script editor contains two comboboxes that allow you to select any section of 
theReport Builder and all events associated with that section. When you select a section and an event, the script editor 

generates a method stub for the event.  



Page 36 of 67          

 

  

 Preview Tab: The Preview tab allows you to quickly view what your report looks like at run time without needing to 
actually run your project. This makes it easy to quickly see the run-time impact of changes you make in the designer or 
the code-behind. To gain a report preview, toggle from the Designer or Script tab to the Preview tab.   
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In Report Builders the Report Explorer serves as the information focal point for your report. From it, you can gain a quick 
overview of the elements that comprise the report, remove individual controls, add parameters and calculated fields, change 
report settings, bind data fields to textbox controls, and modify properties and report behavior via the Properties grid. 

The Report Explorer lays out in one place the sum total of the elements contained in your report. 
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The following demonstrates how you can quickly modify a report using the Report Explorer.  

To remove individual controls   

1. In the Report Explorer, expand the tree that contains the the control you wish to remove. For example, if you want 
to remove a ReportInfo control from a group header, expand the group header that contains the control.   

2. Right-click on the control and select Delete from the shortcut menu.  

3. Click Yes in the Report Explorer dialog to confirm your decision.  

 

To add parameters  

1. In the Report Explorer, right-click on the Parameters node.  

2. Select Add from the shortcut menu.  

3. Set any desired properties or events for the parameter in the Properties grid.  

4. Drag the parameter from the Report Explorer onto the design surface of your report. This will create a textbox object 
that is bound to the parameter. 
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To add calculated fields  

1. In the Report Explorer, expand the Fields tree.  

2. Right-click on the Calculated node.  

3. Select Add from the shortcut menu.  

4. Set any desired properties or events for the field in the Properties grid.  

5. Drag the field from the Report Explorer onto the design surface of your report. This will create a textbox object that 
is bound to the field. 

      

 

To bind data fields to textbox controls  

1. In the Report Explorer, select the data field you want to bind to a textbox control.   

2. Drag the field onto the design surface of the report. A textbox control is created and bound to the field, which is 

reflected in the textbox's DataField  and Name properties. For example, if you dragged a field 
named "EmployeeID," the DataField property of the textbox is set to EmployeeID and the textbox is named 
"txtEmployeeID1."  

To modify properties and report behavior  

1. In the Report Explorer, select the report element you want to modify. The Properties grid displays all available 

properties and events for the element.   

2. In the Properties grid, change any properties or events to implement the changes. 

  

 

Formatting a Report 
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The Report Builder formatting toolbar is made up of the following components:  

 Font--Sets the typeface of the selected label, checkbox, or textbox control  

 Size--Sets the font size of the selected label, checkbox, or textbox control  

 Zoom Out--Incrementally reduces the magnification level of the design surface  

 Zoom In--Incrementally increases the magnification level of the design surface  

 Bold--Sets the bold typeface on or off  

 Italic--Sets the italic typeface on or off  

 Underline--Sets the underline typeface on or off  

 Align Left--Aligns the text left in the control area  

 Align Center--Aligns the text centered in the control area  

 Align Right--Aligns the text right in the control area  

 Justify--Justifies the text in the control area  

 Bullets--Adds bullets to the text in the RichText control area  

 Decrease Indent--Decreases the indent of the text in the RichText control area  

 Increase Indent--Increases the indent of the text in the RichText control area  

toolbox displays a variety of controls available for use in ActiveReports. The items available from the toolbox change 
depending on the designer currently in use. 

 

To access the ActiveReports toolbox  

1. Open a Visual Studio project.  

2. Add an ActiveReport to the project.  

3. Click on View > Toolbox.  

4. Click on the ActiveReports 3.0 tab.  

  

The Reports toolbox is made up of the following components:  

 Pointer--Allows you to select controls or sections of the report  

 Barcode--Allows you to insert an Reports Barcode control  
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 ChartControl--Allows you to insert a chart in any of a variety of styles  

 Checkbox--Allows you to insert a checkbox, bound to a database field or unbound  

 Label--Allows you to insert a new static label control  

 Line--Allows you to insert a line control  

 OleObject--Allows you to insert an OLE object, bound to a database field or unbound  

 PageBreak--Allows you to insert a page break within a selection  

 Picture--Allows you to insert an image loaded from a file  

 ReportInfo--Allows you to display report info in a number of format strings such as {PageNumber} of {PageCount}  

 Textbox--Allows you to insert a textbox, bound to a database field or unbound  

 Shape--Allows you to insert a rectangle, circle or square shape   

 Subreport--Allows you to insert a Subreport control to link to another report  

 RichTextBox--Allows you to insert an RichTextBox control  

 

Field Expressions 

Field expressions can be used in the DataField property to specify textbox output in a report, such as date/time, 
mathematical calculations or conditional values. Any field expression should begin with the equals (=) sign. 

 

Using Field Expressions 

To use a mathematical expression 

Change the DataField property for the text box to the mathematical calculation desired.  

Examples: =UnitPrice+5  

                =Quantity-5 

                =Quantity*UnitPrice 

                =UnitPrice/QuantityPerUnit 

To use a substring 
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Change the DataField property for the text box to the substring needed. If setting up grouping, change the GroupHeader's 
DataField property to the same substring.  

Example: =ProductName.Substring(0, 1) 

To use date/time 

Change the DataField property for the text box to the following.  

Example: =System.DateTime.Now.ToString() 

To create a conditional value 

Change the DataField property for the text box to the conditional statement desired.  

Example: =(UnitsInStock > 0)?"In Stock":"Backorder" 

To concatenate fields 

Change the DataField property for the text box to the following.  

Examples: ="There are " + UnitsInStock + " units of " + ProductName + " in stock." 

                =TitleOfCourtesy + " " + FirstName + " " + LastName 

To round a calculation 

Change the DataField Property for the text box to the following.  

Example: =(double)System.Math.Round(UnitPrice*UnitsOnOrder,2) 

To use modular division 

Change the DataField Property for the text box to the following to get the remainder (2 in this case).  

Example: =22%(5) 

To replace a null value 

Change the DataField Property for the text box to the following to replace nulls with your own value.  

=(Region == System.DBNull.Value) ? "No region specified" : Region 

 

To add a hyperlink to a report at design time, click on the appropriate control within the ActiveReport designer and set the 
HyperLink property for it in the Properties window. 
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Viewing and Printing a report 

To view or print a report, select ‘Preview’ tab at the bottom of the report designer, and select the print icon to 

print (seen below): 
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Grouping Data in a Report 

To group data in a report  

1. Right-click in the Detail section of the report design surface, select Insert, and click on Group Header/Footer.  

2. This will insert a new group header/footer section into your report.  

3. In the Properties window for the group header, change the DataField property to the field on which you want your 
data grouped.  

4. Change the name of the group header to reflect the field on which data is being grouped.  For example, 
"ghCategories" would be the name of the group header field with the DataField property of "CategoryID".  

Exporting a Report 

To export a report to MS Excel and other formats, first preview the report by selecting the ‘Preview’ tab. Next, 

from the File menu, select ‘Export’.  
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Next, select the format to export to and the file destination. 

 

Saving and opening a report 

The report builder tool enables user to create and save multiple reports. To save a current report as an RPX file 

1. While in the design view, select Save from the File menu.  
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2. Name the file appropriately and select the location in which to save it.  

 

3. Click Save to save the selected report layout.  

To load an existing RPX file 

1. While in the Report Builder, click File > Open.  

2. Select the RPX file from the appropriate location.  

3. Click Open to load the selected report layout.  
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4. The saved report will appear in the designer section. 

 

Connecting to the database and other data sources: 

The report designer is automatically connected to the contract database. However, the report builder enables a 

report to be connected to the Contract Insight directly, which is normally located in the C:\Program 

Files\CobbleStoneSystems\ContractInsightDE folder. Your installation path may vary depending on the path selected 

during installation.  The report builder may also be connected to any other datasource for reporting.  To edit the 

data source, select the Fields item, and then select ‘Edit Data Source’ seen below.  
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 Data Source  

The Data Source option allows access to add Data Source parameters or modify existing Data Source settings. 

 

 

Report Builder makes it easy to bind your report to other data sources by using the gray DataSource icon located in the 
Detail section of the report design surface or by accessing the DataSource dialog from the Report Settings menu. 

 

To use the DataSource icon  

1. From the report design surface.  

2. Click on the gray DataSource icon in the Detail section of the report to open the Datasource dialog.  

3. You will then be prompted to select your data source, connection string, and query.  

ms-help://dd.ActiveReports3.1033/ddARNET3/ar3tskUsingtheDataSourceIcon.html
ms-help://dd.ActiveReports3.1033/ddARNET3/ar3tskUsingtheDataSourceIcon.html
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To connect to Microsoft Access using Jet 4.0  

1. Click on the gray report DataSource icon in the Detail section to open the Datasource dialog.  

2. Select the OLE DB tab.  

3. Click on Build.  

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next.  

5. Enter a database name or Click the ellipsis button to browse for the access path to a database.  

6. Click Open once you have entered a database name or selected the appropriate access path.  

7. Click OK to continue.  

8. Enter a SQL statement in the Query box (e.g. "Select * from products").  

9. Click OK to return to the report design surface.  

To connect to SQL Server  

1. Click on the gray report DataSource icon in the Detail section to open the Datasource dialog.  

2. Select the SQL tab.  

3. Click on Build.  

4. Select "Microsoft OLE DB Provider for SQL Server" and click Next.  

5. Select a server.  

6. Chose Windows integrated security or a specific username and password.  

7. Choose the database for connection and click OK.  
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8. Enter a SQL statement in the Query box (e.g. "Select * from products").  

9. Click OK to return to the report design surface.  

To connect to an XML database  

1. Click on the gray report DataSource icon in the Detail section to open the Datasource dialog.  

2. Select the XML tab.   

3. Click the ellipsis button beside File URL to browse for the access path to Customer.xml.  

4. Click Open once you have selected the appropriate access path.  

5. In the Recordset Pattern field, enter a pattern (e.g. "//ITEM").  

6. Click OK to return to the report design surface.  

  

To use a dataset at design time, add the necessary data controls to the Report, set the report's DataSource and DataMember 
properties, and bind the report's controls to the corresponding data fields  

 If your project already contains a dataset that you want to use within the Report designer, drag the DataSet object from 
the Data tab of the toolbox onto the report surface. This will open the Add Dataset dialog. To add your dataset, select 
the Typed dataset option then choose your dataset.  

 

To add data controls to the Report 

1. While in an Report, click the Data toolbox tab. Select any available DataAdapter object and drag it onto the report 

surface; the Data Adapter Configuration Wizard will open and you will see a visual representation of the DataAdapter 
object in the Reports component tray.   

2. Click Next.   

3. Click New Connection, which will open the Data Link Properties dialog, and select the "Provider" tab.  

4. Select the appropriate provider.  

5. Select the "Connection" tab and enter or browse for the path to the desired database file and click OK to close the 
dialog and return to the Configuration Wizard.  

6. Click Next twice, enter the appropriate SQL Select statement and click the Next button again.  
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7. Click Finish to close the wizard. A connection object will now reside with the DataAdapter object in the ActiveReports 
component tray.  

8. To generate the dataset, right-click the DataAdapter object, click on "Generate DataSet," select "Add this dataset the 
the designer," and click OK.  

To set the report's DataSource and DataMember properties  

1. Click in the gray area of the design area to select the ActiveReport.  

2. From the Properties grid, set the DataSource property to the newly generated dataset and the DataMember to the 
DataTable.  

 

After setting the report's data source, all bound fields appear under the Bound node, which is accessed by expanding the 
Fields node in the Report Explorer. 
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To bind the report's controls to the corresponding data fields 

 

Adding Custom Code to a Report 

Use the Script tab and AddCode method to inject code into the script.  

The AddCode method allows actual code segments to be added to the script at run time. This is useful for allowing secure 
information, such as a database connection string or SQL query string, to be used inside the script without having to save it 
into the RPX file.  

'Visual Basic 

Public Function addThisCode() As String  

   Dim sCode As String = "Public Function ShowACMessage() As String" _ 

    + Environment.NewLine + "ShowACMessage = ""my Added Code""" _ 

    + Environment.NewLine + "End Function" 

   addThisCode = sCode  

End Function  

 

Private Sub rptAddCode_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _  

    Handles MyBase.ReportStart  

      Me.AddCode(addThisCode())  

End Sub  

 

'VB.NET Script 
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Public Sub Detail1_Format() 

   CType(rpt.Sections("Detail1").Controls("TextBox1"), TextBox).Text = ShowACMessage() 

End Sub 

 

Adding Parameters to a Report 

In Report Designer, the Parameters dialog can be used to prompt for user input when reports are generated. If you add 
"<%FieldName | PromptString | DefaultValue | Type %>" to the report's SQL string, the Parameters dialog appears when 
the report opens.   

This walkthrough illustrates the basics of using parameters in simple reports. 

Connecting the report to a data source 

To connect the report to a data source 

1. Open Report builder, click on the gray report DataSource icon in the Detail section to open the report DataSource 

dialog.  

2.  

  

3. In the SQL query field, type "SELECT * FROM [contractual_table]  WHERE contract_end_date =#<%Date|End 

date:|1/1/1994|D%>#".  

4. Click the report design surface to return to the report design surface.  

5. To preview or print the report, select the “Preview’ tab 
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Custom Reports Using Microsoft Access 
 

Items Required:  

1. Microsoft Access installed on your computer.  

2. The location of your "Contract.mdb" file. The file will be either on your hard drive or on the 

network.  

3. The appropriate network permissions. Contact your network administrator for help.  

 

Creating a Custom Report:  

1. Open MS Access, create a new database. Select a name for your new database. Remember the 

name, you will use this database as your interface to the contract data.  

2. In MS Access select "File" from the Menu.  

3. Select "Get External Data", and then select "Link Tables".  

4. Browse to the location of your "Contract.mdb" file. By default the file is stored in the following 

location "c:\program files\Contract Management Software\Contract.mdb" (other the proper 

directory for your installation, please contact your IT help staff for more information).  

5. Select the "Contract.mdb" file.  

6. Select the "Select All" button. Next, select "OK". The links to the tables should appear in your 

new database.  

7. Next, import the "Contractual Query" by selecting "Get External Data", "Import Data" from the 

Menu.  

8. Browse to the location of your "Contract.mdb" file.  

9. Select the "Contract.mdb" file.  

10. Select the "Queries" tab from the top of the form.  

11. Select the "Contractual Query". Next, select "OK". The queries will now be imported to your 

new database.  

12. You can now use the Microsoft Access Report Writer by selecting the "Reports" Tab and then 

selecting the "New" button.  

13. Refer to your MS Access documentation or the MS Access help file to create your own custom 

reports.  

14. Create a Report with an MS Access Report Wizard:  

15. In the Database Window of your new database, click the Reports Tab.  

16. Click New.  

17. In the New Report dialog box, select the wizard that you want to use. A description of the wizard 

appears in the left side of the dialog box.  

18. Click the table or query that contains the data you want to base your report on.  

19. Click OK.  

If the resulting report doesn’t look the way you want, you can change it in Design view.  

 

Exporting Data 
 

The System allows authorized users to export data to analyze in third party tools such as Microsoft 

Excel or MS Access. To export data, follow the same instructions found in the Custom Report section of 

this manual.  Once, you establish a linked table to the Contract.mdb file, you may use Microsoft Access 

to export data. Refer to the Microsoft Access help files for more information.  
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Contract Insight Desktop Edition Task Emailer Application 
 

Installation: 

It is recommended to install the Task Emailer application on a Windows server where the shared Contract.mdb 

database (name may vary) is located. NOTE: The Task Emailer Application is a separate add-on.  

Requirements for this method of installing e-mail alerts: 

1. The SMTP Server name or IP address that will be used to route e-mails 

2. The user name and password if the SMTP server requires authentication 

3. Admin level permissions to the Contract.mdb access database (name and path may vary)  

4. The correct permissions to install the Microsoft .NET Framework on the Windows Server. 

5. Correct permissions to schedule and create a Windows Task Scheduler job on the Windows Server. 

 

Download and Install the Microsoft .NET Framework from Microsoft’s website 

Note: The .NET Framework should be installed on the Windows Servers. To download and install the .NET 

Framework visit Microsoft.com and run the system updates or go to 

http://www.microsoft.com/downloads/ search for the Microsoft .NET Framework  and follow the instructions. 

 

First, locate Contract.mdb database (name and path may vary) on the Windows Server.  

Next, locate and run the ‘ContractInsightTaskEmailer.msi’ installation file provided by CobbleStone Systems. 

Follow the installation wizard: 

 

 

http://www.microsoft.com/downloads/
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When complete the installation confirmation screen will appear: 



Page 58 of 67          

 
 

After the installation is complete, it is required to set the correct configuration file settings. The configuration 

file can be found at: C:\Program Files\CobbleStoneSystems\ContractTaskEmailer\  (installation path may vary). 

Select and open the application configuration file (.config) (via Notepad) located at:  C:\Program 

Files\CobbleStoneSystems\ContractTaskEmailer\ (path may vary). 

 
Using Notepad, edit the following application settings in the TaskEmailApp.exe.config file:  
Next, update the following variables in the configuration file by changing the values for each variable: 
 

1. STMPSERVER: this is the name or IP address of the SMTP server to route the emails through (note: this 

STMP server should allow the relaying of emails from the machine that this application is installed on) 

2. EmailFrom: this is the variable for specifying the e-mail address that the contract and tasks emails are sent 

from. This should be a well formatted email address in the name@domain.com format. 

3. EmailCC: this and optional variable that is to be used to specify an e-mail account to receive a copy of each 

email sent. This variable can be left blank (“”) if you do not have to copy each email to a specific account. 
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4. SMTPPort: The SMTP Port is normally 25. This is the port that the SMTP server is listening on. Check with 

your e-mail administrator for the correct SMTP Port. 

5. APPENDCONTRACTEMAILSUBJECT: This variable can be used to append a subject to the Contract 

Email alerts. This variable can be left blank (“”) if you are not required to append any text to the subject of 

contract alerts. 

6. APPENDTASKEMAILSUBJECT: This variable can be used to append a subject to the Task Email alerts. 

This variable can be left blank (“”) if you are not required to append any text to the subject of tasks alerts. 

7. DATA SOURCE: update both areas with the full folder path and file name to the Contract.mdb database 

(path and name may vary).  

8. DBPath: this is the path to the contract.mdb file.  

9. DBProvider:  typically left as "Microsoft.Jet.OLEDB.4.0"  

10. Save and Close the configuration file. 

11. Screen shot of a typical configuration file (below): 

 
To test the Task Emailer application, you may double click the TaskEmailerApp.exe file and note any error 

messaged on the console. If any error messages are noted, please contact CobbleStone Systems at 

support@CobbleStoneSystems.com.  

mailto:support@CobbleStoneSystems.com
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Scheduling the Task E-mailer Application to run on a daily basis 

The task e-mailer application may be scheduled to run on a daily (or routine) basis. It is recommended to use 

the Windows Tasks Scheduler to schedule the TaskEmailerApp.exe file to run on a routine basis (typically each 

night at 1 AM). NOTE: please follow the Microsoft Windows instructions for scheduling a .exe file to run via 

the Windows Schedule and be sure to set the appropriate permissions for the scheduled task to run under.  

NOTE: Be sure to verify the Windows Servers instructions for creating a schedule task as procedures between 

various version of Windows Servers differ.  

1. Open the Windows Tasks Scheduler 

 
2. Select browse to browse to the TaskEmailerApp.exe file (installed above) 
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3. Locate the TaskEmailApp.exe file (installed above) and select Open 

 
4. Next, select Daily on the task interval screen below. 
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5. Next, enter the start time of the task to run each day (normally after midnight) 

 
6. Select Next, and enter a local admin account for the task to run under 
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7. Click next to finish the task setup. 

Double click on the task to verify that the tasks runs successfully. Be sure to monitor the task event log and 

Windows Event Log for e-mail errors.   If there are any errors or questions, please contact 

support@CobbleStoneSystems.com  

mailto:support@CobbleStoneSystems.com
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System Limitations 
 

The desktop edition is limited to ten concurrent users and has a total database limitation of 1 GB. 

However, this means that you can track as many contracts as you wish until the database reaches 1 GB 

in size. CobbleStone System’s enterprise edition does not have a limitation on the database size.  To 

contact CobbleStone Systems to upgrade to the Contract Management Enterprise Edition (at a 

discounted price) see the information below.  

 

Upgrading to the Contract Enterprise Edition 
 

CobbleStone offers a many more features in their Contract Management Enterprise Edition.  To learn 

more about how you can have unlimited scanned documents, attached files, customized fields, 

customized reporting, e-mail alerts, multiple levels of security, contract creation and templates, tasks 

and workflow, vendor negotiation and more, please visit our website at: 

http://www.CobbleStoneSystems.com  

 

Support and General Questions Contact Information 
 

If you have a question about our products or would like a demo and pricing please contact us.  

Telephone: 1-866-330-0056  

Electronic mail: info@CobbleStoneSystems.com  

Support e-mail: support@CobbleStoneSystems.com  

Website: http://www.CobbleStoneSystems.com   

 

http://www.cobblestonesystems.com/
mailto:info@CobbleStoneSystems.com
mailto:support@CobbleStoneSystems.com
http://www.cobblestonesystems.com/
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End User Software License Agreement  
 
PLEASE READ THIS SOFTWARE LICENSE AGREEMENT ("LICENSE") CAREFULLY BEFORE USING THE 

SOFTWARE. BY USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS 

LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE THE SOFTWARE. IF YOU DO 

NOT AGREE TO THE TERMS OF THE LICENSE, YOU MAY RETURN THE SOFTWARE TO COBBLESTONE 

SYSTEMS CORP (THE COMPANY) FOR A REFUND. IF THE SOFTWARE WAS ACCESSED ELECTRONICALLY, 

CLICK "DISAGREE/DECLINE". FOR SOFTWARE INCLUDED WITH YOUR PURCHASE OF HARDWARE, YOU 

MUST RETURN THE ENTIRE HARDWARE/SOFTWARE PACKAGE IN ORDER TO OBTAIN A REFUND.  

 

IMPORTANT NOTE: This software may be used to reproduce materials. It is licensed to you only for reproduction of non-

copyrighted materials, materials in which you own the copyright, or materials you are authorized or legally permitted to 

reproduce. If you are uncertain about your right to copy any material, you should contact your legal advisor.  
 

1. General. The Contract Insight, CMTS, Contract Management Software, and Contract Management Tracking Software (collectively 

the “software”), documentation and any fonts accompanying this License whether on disk, in read only memory, on any other media 

or in any other form (collectively the "Contract Software") are licensed, not sold, to you by CobbleStone Systems Corp. 

("CobbleStone") for use only under the terms of this License, and CobbleStone reserves all rights not expressly granted to you. The 

rights granted herein are limited to CobbleStone's and its licensors' intellectual property rights in the CobbleStone Software and do not 

include any other patents or intellectual property rights. CobbleStone retains ownership of the CobbleStone Software itself. The rights 

granted under the terms of this License include any software upgrades that replace and/or supplement the original CobbleStone 

Software product, unless such upgrade contains a separate license.  

 

Title and intellectual property rights in and to any content displayed by or accessed through the CobbleStone Software belongs to the 

respective content owner. Such content may be protected by copyright or other intellectual property laws and treaties, and may be 

subject to terms of use of the third party providing such content. This License does not grant you any rights to use such content.  

 

2. Permitted License Uses and Restrictions. This License allows you to install and use one copy of the CobbleStone Software on a 

single computer at a time. This License does not allow the CobbleStone Software to exist on more than one computer at a time, and 

you may not make the CobbleStone Software available over a network where it could be used by multiple computers at the same time. 

You may make one copy of the CobbleStone Software in machine-readable form for backup purposes only; provided that the backup 

copy must include all copyright or other proprietary notices contained on the original. Except as and only to the extent expressly 

permitted in this License or by applicable law, you may not copy, decompile, reverse engineer, disassemble, modify, or create 

derivative works of the CobbleStone Software or any part thereof. THE COBBLESTONE SOFTWARE IS NOT INTENDED FOR 

USE IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR 

TRAFFIC CONTROL SYSTEMS, LIFE SUPPORT MACHINES OR OTHER EQUIPMENT IN WHICH THE FAILURE OF THE 

COBBLESTONE SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR 

ENVIRONMENTAL DAMAGE.  

 

3. Transfer. You may not rent, lease, lend or sublicense the CobbleStone Software. You may, however, make a one-time permanent 

transfer of all of your license rights to the CobbleStone Software to another party, provided that: (a) the transfer must include all of the 

CobbleStone Software, including all its component parts, original media, printed materials and this License; (b) you do not retain any 

copies of the CobbleStone Software, full or partial, including copies stored on a computer or other storage device; and (c) the party 

receiving the CobbleStone Software reads and agrees to accept the terms and conditions of this License.  

 

Updates: If an CobbleStone Software update completely replaces (full install) a previously licensed version of the CobbleStone 

Software, you may not use both versions of the CobbleStone Software at the same time nor may you transfer them separately.  

 

NFR (Not for Resale) Copies: Notwithstanding other sections of this License, CobbleStone Software labeled or otherwise provided 

to you on a promotional basis may only be used for demonstration, testing and evaluation purposes and may not be resold or 

transferred.  

 

4. Consent to Use of Data. You agree that CobbleStone and its subsidiaries may collect and use technical and related information, 

including but not limited to technical information about your computer, system and application software, and peripherals, that is 

gathered periodically to facilitate the provision of software updates, product support and other services to you (if any) related to the 

CobbleStone Software. CobbleStone may use this information, as long as it is in a form that does not personally identify you, or 

release your data, to improve our products or to provide services or technologies to you.  

 

5. Termination. This License is effective until terminated. Your rights under this License will terminate automatically without notice 
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from CobbleStone if you fail to comply with any term(s) of this License. Upon the termination of this License, you shall cease all use 

of the CobbleStone Software and destroy all copies, full or partial, of the CobbleStone Software.  

 

6. Limited Warranty. CobbleStone warrants the software to be free from defects in materials and workmanship under normal use for 

a period of ninety (90) days from the date of original purchase. Your exclusive remedy under this Section shall be, at CobbleStone's 

option, a refund of the purchase price of the product containing the CobbleStone Software or replacement of the CobbleStone 

Software which is returned to CobbleStone or an CobbleStone authorized representative with a copy of the receipt. THIS LIMITED 

WARRANTY AND ANY IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY, OF SATISFACTORY QUALITY, AND OF FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED 

IN DURATION TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE. SOME JURISDICTIONS DO 

NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT 

APPLY TO YOU. THE LIMITED WARRANTY SET FORTH HEREIN IS THE ONLY WARRANTY MADE TO YOU AND IS 

PROVIDED IN LIEU OF ANY OTHER WARRANTIES (IF ANY) CREATED BY ANY DOCUMENTATION OR PACKAGING. 

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS 

WHICH VARY BY JURISDICTION.  

 

7. Disclaimer of Warranties. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE COBBLESTONE 

SOFTWARE IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, 

ACCURACY AND EFFORT IS WITH YOU. EXCEPT FOR THE LIMITED WARRANTY SET FORTH ABOVE AND TO THE 

MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE COBBLESTONE SOFTWARE IS PROVIDED "AS IS", 

WITH ALL FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND COBBLESTONE AND COBBLESTONE'S 

LICENSORS (COLLECTIVELY REFERRED TO AS "COBBLESTONE" FOR THE PURPOSES OF SECTIONS 7 AND 8) 

HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE COBBLESTONE SOFTWARE, 

EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

AND/OR CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR 

PURPOSE, OF ACCURACY, OF QUIET ENJOYMENT, AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. 

COBBLESTONE DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE COBBLESTONE 

SOFTWARE, THAT THE FUNCTIONS CONTAINED IN THE COBBLESTONE SOFTWARE WILL MEET YOUR 

REQUIREMENTS, THAT THE OPERATION OF THE COBBLESTONE SOFTWARE WILL BE UNINTERRUPTED OR 

ERROR-FREE, THAT THE COBBLESTONE SOFTWARE WILL BE COMPATIBLE WITH THIRD PARTY SOFTWARE, OR 

THAT DEFECTS IN THE COBBLESTONE SOFTWARE WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION 

OR ADVICE GIVEN BY COBBLESTONE OR AN COBBLESTONE AUTHORIZED REPRESENTATIVE SHALL CREATE A 

WARRANTY. SHOULD THE COBBLESTONE SOFTWARE PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF 

ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 

OF IMPLIED WARRANTIES OR LIMITATIONS ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE 

ABOVE EXCLUSION AND LIMITATIONS MAY NOT APPLY TO YOU. CobbleStone, its officers, affiliates and subsidiaries shall 

not, directly or indirectly, be liable, in any way, to you or any other entity for any inaccuracies, errors in or omissions from the 

content.  

 

8. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL COBBLESTONE BE 

LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES 

WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS 

INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR 

USE OR INABILITY TO USE THE COBBLESTONE SOFTWARE, HOWEVER CAUSED, REGARDLESS OF THE THEORY 

OF LIABILITY (CONTRACT, TORT OR OTHERWISE) AND EVEN IF COBBLESTONE HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY FOR 

PERSONAL INJURY, OR OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY 

TO YOU. In no event shall CobbleStone's total liability to you for all damages (other than as may be required by applicable law in 

cases involving personal injury) exceed the amount of fifty dollars ($50.00). The foregoing limitations will apply even if the above 

stated remedy fails of its essential purpose.  

 

9. Export Law Assurances. You may not use or otherwise export or re-export the CobbleStone Software except as authorized by 

United States law and the laws of the jurisdiction in which the CobbleStone Software was obtained. In particular, but without 

limitation, the CobbleStone Software may not be exported or re-exported (a) into (or to a national or resident of) any U.S. embargoed 

countries (currently Cuba, Iran, Libya, North Korea, Sudan and Syria) or (b) to anyone on the U.S. Treasury Department's list of 

Specially Designated Nationals or the U.S. Department of Commerce Denied Person's List or Entity List. By using the CobbleStone 

Software, you represent and warrant that you are not located in, under control of, or a national or resident of any such country or on 

any such list.  

 

10. Government End Users. The CobbleStone Software and related documentation are "Commercial Items", as that term is defined at 

48 C.F.R. §2.101, consisting of "Commercial Computer Software" and "Commercial Computer Software Documentation", as such 
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terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. 

§227.7202-1through §227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software 

Documentation are being licensed to U.S. Government end users (a) only as Commercial Items and (b) with only those rights as are 

granted to all other end users pursuant to the terms and conditions herein. Unpublished-rights reserved under the copyright laws of the 

United States.  

 

11. Controlling Law and Severability. This License will be governed by and construed in accordance with the laws of the State of 

New Jersey, as applied to agreements entered into and to be performed entirely within New Jersey between New Jersey residents. This 

License shall not be governed by the United Nations Convention on Contracts for the International Sale of Goods, the application of 

which is expressly excluded. If for any reason a court of competent jurisdiction finds any provision, or portion thereof, to be 

unenforceable, the remainder of this License shall continue in full force and effect.  

 

12. Complete Agreement; Governing Language. This License constitutes the entire agreement between the parties with respect to 

the use of the CobbleStone Software licensed hereunder and supersedes all prior or contemporaneous understandings regarding such 

subject matter. No amendment to or modification of this License will be binding unless in writing and signed by CobbleStone. Any 

translation of this License is done for local requirements and in the event of a dispute between the English and any non-English 

versions, the English version of this License shall govern.  

 

 


